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RDi currency

Which is most recent version actively used in your shop?

1. Green screenonly (1970-1990)
2. CODE/400 (1990-2000)
3. WDSc (2000- 2009)
4. RD Power 7.x or 8x (2010-2012)
5. RDi 9.0.x (2013)

6. RDi9.1.x (2014)

7. RDi95 (2015 Sep)
8. RDi9.5.1 (2016 Sep)
9. RDi95.1.1 (2016 Dec)

© 2016 IBM Corporation



Top Concerns for IBM i IT — Help Systems Survey 2016

_ 58.3% [ i e fe
_ 39.2% High availability
_ 37.7% Mobile access
_ 37.7% [ IBM i skills depletion
30.0% Reduce IT spending

29.5% SOL database access

26.3% Analytics/business intelligence beyond Query/400

© 2016 IBM Corporation



Improvements from modernization — Profound Logic Survey

© 2016 IBM Corporation

EASIER/FASTER
APPLICATION DEVELOPMENT

EASIER TO FIND/
TRAIN DEVELOPERS

MORE CONNECTED
BUSINESS (WEB SERVICE)

EASIER APPLICATION
MAINTENANCE

MORE COMPETITIVE/
PROFITABLE BUSINESS

SUPPORT FOR REMOTE TEAMS
WITH MOBILE APPLICATIONS
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Remove 8-80 Column Restriction

Today column 1-8 are reserved (goes back to the punch card days)
Max Column for content is 80 (again....punch card)

Line 4 Column 1 Insert 5 changes

I_-_+_---1----+----2----+----3----+----4----+----5----+----6----+----?----+----8----+----9.-
S/ Compiler options

S/ Code and comments can now extend well beyond the 80-column limit, allowing much greater f
ktl—opt ALLOC(*TERASPACE) NOMAIMN TEXT( 'long and meaningful description text for this');

S/Files and definitions
dcl-ds progStatus PSDS;

procedure *proc;
end-ds;

* If column 1 of a source line contains **FREE", the following lines contain free-
form RPG code beginning in column 1 and continuing to the end of the line

 If *FREE has not appeared in the source file, the following lines have RPG
code in columns 6 — 80.

© 2016 IBM Corporation



» Modern coding style
— Easier to code and maintain

— Easier for new programmers
* But older code still works ~ Value Proposition
« Easily express business logic

* New and enhanced built-
in functions to improve
string processing

« Use ALIAS names for all

« CCSID support for externally-described files

a|phanumeric data Relaxed rules for data
= Alphanumeric subfields in structures for 1/0
external data structures operations
71 ggqhhea}ggléh% ?ﬁgnfe”eCCSID * Enhancements related to
= Free-form H, F, D and P » Implicit CCSID conversion null-capable fields
statements for concatenation « Usability enhancements
= Removal of 8-80 column limit = Option to open database for generated PCML
files without CCSID .
= Sort and search data structure conversion e Maximum number of
arrays _ _ « /SET and /RESTORE parameters for a bound
= Sort ascending or descending directives to temporarily call increased to 16,382
= %SCANRPL built-in function change the default CCSID
= Support for ALIAS names in files or date/time format
and data structures » More control for %SUBDT
= Relaxed rules for data structure 1/0O = 0 and 12 fractional
= Faster return values with seconds for timestamps
RTNPARM
= %PARMNUM built-in function
= Optional prototypes
= Implicit CCSID conversion for All of these
parameters features are NOT
= Teraspace storage model _ suppo rted by
= CCSIDCVT keyword to notify about I
conversion errors SEU!

= Encrypted listing debug view

© 2016 IBM Corporation



How is this changing the game?

Developer, W g
Arkansas Electric Cooperatife Corporath) " » 2

Hear how Modern RPG and Tools allows a
23 year old developer to be success today!

© 2016 IBM Corporation
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http://bit.ly/1WhM7uT
http://bit.ly/1WhM7uT

Development tools....

=8 Session & - [24 x 80]

Ml

Tried and True, Yes but also SLOW, OLD, No new features

© 2016 IBM Corporation 10



Tools

Use the right
tool for the job!

Cost $500

© 2016 IBM Corporation 12



Rational Developer for |

o Modern, Eclipse-based, development tools for IBM i

o Visual editors, outline views, content assist, integrated language help

o Integrated file management, search, edit, compile/build, debug capabilities
o Analysis tools (application diagram, call hierarchies, type hierarchies)

o Easily debug batch, interactive, and Web applications with a common visual
ggbuéger —%ngyze code coverage (\)/1y testsIO P

o Visual DDS design tools: Screen and Report Designer
o Supports RPG, COBOL, C, C++, SQL, DDS

|
* | [ Remote System Explover

£ Outline

File Edit Source Compile(G) Navigate Search Project Run Window Help

#Remote Systems 13 | 7

£m
intainSelection();
TR ST T o o
Local D
ARomoie system ] IS 05, S TOTDRIS: . OLETOX L 3] “ T
180  Development
- | Name | Auioue Ten - =
= asatc = e
T rn aa wGM Cue debuggable, calls Payrold,parm workstation rum
an oG cue debuggable, cals Payrlig, parm workstation num
MyCOVPRE o
oAYROI oM RPGIE =
Command |Normal - - tl I e J O b I
M
Messages - Show Log
Replace 814
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« Tightly integrated -
« Edit/Compile/Debug

» Program Understanding

» Code Coverage Analysis

* Extensible by IBM

9.5.1
= Mac Support
= Kerberos Support

* Extensible by ISVs
 Extensible by open source =

9.1.0
= Code Coverage

9.5.0.2

=Improved context-
sensitive help in fixed

= Synchronize Eclipse
projects with IFS

9.5 format = RPGLE outline
=Fully Free RPG — *Prototype parameter = Full O-Spec support
no column

restrictions
=Integrated 5250

names in content
assist

=Improved indentation

= Improved I-Spec
support

= Improved indicator

. I emulator
9.0.0 = Search/Filter within “ILE RIgG support support
o ILE RPG outline view : h . 21 fixes = Filter out
= Hover over RPG « Quick open for indentation action unreferenced
85.1 reference Browse. =Dramatic Code =9.5.0.3 = Comment shortcuts
* Live ILE RPG outline = Hyperlink to RPG « F1 hel RPG Coverage oy for CLLE and DDS
[ déclaration elp on performance =Language support for
view opcode/ keyword/ improvement IBMi7.3 = Syntax error
= Improved i Project = Improved Content BIE pr i U annotations
support Assist « 7 RFEs =Snippet support in =Windows 10 support B e e teninto
= Inclusion of IBM Data = Improved CL support 44 push-to-client ' in content assist
Studio = 9 RFEs xes *Improved RPG » Integrated ACS
i ; : Content Assist MK .
= 64-bit operation = 39 fixes 9.1.1 o supports Visual Explain
system support = Push-to-client .UpdgtfwaOSf(ljetr f
- 8 RFEs 9.0.0.1 configuration backup " Softare News . = 18 RFEs
= 36 fixes = 11 fixes . é“‘éd'ét”b“t'on . =Eclipse 4.4.2 = 4 features
O e o> for *IBM Java 8 =19 fixes
jobs o
9.0.1 « SQL formatting »10 RFEs =Syntax highlighting for
= Free-form ILE RPG improvements u52 fixes UIM source =951.1

declarations
Improved syntax

= Mark occurrences of
all RPG declarations

=Push to Client saves
custom perspectives

*RPG Refactoring
support

highlighting in editor ;EP\Qi%Cgehlgngfg?ge =Default to browse pref
- |mpr0Ved_ = 8 RFEs embedded SF()?L in =19 fixes

visualization of = 57 fixes RPG

block nesting )
« 4 RFEs 0111 =31 fixes
" 49 fixes = 14 fixes

© 2016 IBM Corporation
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http://www.ibm.com/support/knowledgecenter/SSAE4W_9.5.0/com.ibm.etools.iseries.rse.doc/topics/acs_run_sql_scripts.html
http://www.ibm.com/support/knowledgecenter/SSAE4W_9.5.0/com.ibm.etools.iseries.rse.doc/topics/acs_ovr.html
http://www.ibm.com/support/knowledgecenter/SSAE4W_9.5.0/com.ibm.etools.iseries.rse.doc/topics/tblock_nesting.html

Interim fix available for 9.5.1 ***Included in 9.5.1.1***

* A problem was found using the Find Next Error/Find Previous Error actions in
the Remote Systems LPEX Editor.

— APAR SE65785 RDI 9.5.1 ERROR LIST FIND NEXT ERROR ICONS OR
KEYS NOT WORKING IN THE REMOTE SYSTEMS LPEX EDITOR

* |Interim fix available from FixCentral

© 2016 IBM Corporation 15


https://www.ibm.com/developerworks/community/blogs/49773f8f-a20d-4816-86f2-44a2d862dbc1/entry/Interim_fix_for_APAR_SE65785_RDI_9_5_1_FIND_NEXT_ERROR_ICONS_OR_KEYS_NOT_WORKING_IN_THE_REMOTE_SYSTEMS_LPEX_EDITOR?lang=en

Update to latest IBM Installation Manager

* In IBM Installation Manager preferences, select ‘Search for IBM Installation
Manager updates’ on Updates page.

@ Preferences

type filter text Updates

Repositaries i i X 3
P The Installation Manager can optionally search for updates to itself whenever any of the following pages are o)

Appearance
Files for Rollback Install Packages
+ Help Modify Packages
» Internet Update Packages
Passport Advantage
Secure Storage And when clicking the "Check for Other Versions, Fixes, and Extensions” button on the "Install Packages” page.
Updates

Search for Installation Manager updates

 Windows users should be at 1.8.5.1 at least

© 2016 IBM Corporation
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https://www.ibm.com/developerworks/community/blogs/49773f8f-a20d-4816-86f2-44a2d862dbc1/entry/Windows_users_should_update_IBM_Installation_Manager_to_1_8_5_1?lang=en

What’s new in RDi 9.5.1

* Mac Support
Kerberos Support
Synchronize Eclipse projects with IFS

RPGLE outline

* Full O-Spec support

* Improved I-Spec support

« Improved indicator support
» Filter out unreferenced

Integrated ACS supports Visual Explain

« Comment shortcuts for CLLE and DDS

e Syntax error annotations

« More parameter info in content assist

* Improved language sensitive help in embedded SQL

© 2016 IBM Corporation 17



RDi is now on Mac!!THTHT

 After install: start RDi.app

ey
<

Favorites

E Al My Files

¢ iCloud Drive
@) Airbrop

¥ Applications
[ Desktop

¥ Documents

0 Downloads

ﬁ‘ rdimac

Devices

oo
oo

= [E] o

~ Applications
= Library
“] System

»  User Information

o Users

& Macintosh HD =

¥ vvYyvyw|

“ Applications »

- SoftwareDeliveryPlatform

th |

IBM

IBM Application Support
@ 1BM Firefox.app
&) IBM i Acces...olutions.app
it |IBM Motes.app

) iBooks.app

@ |mage Capture.app

# iMovie.app
"% iPhoto.app
(1) iTunes.app

5 Keynote.app

& Launchpad.app
2 MarmIRM Ann Stare ann

IBM > SoftwareDeliveryPlatform

Q. Search

InstallationManager

B softwareDeliveryPlatform »

© 2016 IBM Corporation

artifacts.xml
configuration
eclipse
Eclipse.app
epl-v10.html
jdk

lum

notice. html
p2

plugins

rdi

RDi.app
reacdme
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Starting up on Mac

’i ..... RD| ..... |:||e ..... Ed't ..... Nawgate ..... S earCh ..... pmle,:t ..... Run ..... Wmdow ..... H e[p' .......................................................................................
F ——_—— ’ i

| RN | Remote System Explorer - IBM i RSE Introduction - IBM Rational Developer for i
T A5 O Qur i S0 . BRI IHe et G
(|
A8 Remote 5y... 52 ] . Team = O || IBM i RSE Getting Started i3 | =
S = I . .
& &) e IBM i Remote System Explorer Getting Started
» Ef Local N * Intreduction
Welcome to the Remote System Explorer (RSE). The RSE provides an integrated development
environment for IBM | programmers. It allows you to work with your libraries, objects, members, jobs and
IFS files, as well as edit source members, compile programs and debug applications.
We recommend that you follow the steps below to quickly get started using the RSE. This overview is
meant to help you find some of the key features of the RSE. Each step also includes a link to additional
information in the on-line help. There are also PDM to RSE and an SEU to LPEX transition guides
available in the on-line help with more information en how to move from green screen programming
tools to the RSE.
The topics below assume you are in the Remote System Explorer perspective with the default
Workbench layout. Look in title bar for this Window to see which perspective you currently have open. If
this is not the Remote System Explorer then select Window » Open Perspective > Other and select the
Remote System Explorer from the list.
You can click the help (7) butten to view more information on each step in the on-line help.
] Click to Begin
P Creatinn A Connection to Your IRM | sareer (
jﬂ Remote System Details 53 | o= Tasks B, Object Table FE'; Commands Log )i-l Terminal:
[Tl Propert... 53 | Eﬂb_ Remote... =i
YR
Rroperty Value
Name New Connection
MNumber... O
Type An expandable pr...

© 2016 IE 19
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Editing on Mac

o RDi File Edit Source Compile(G) Navigate Search Project Run Window Help

- @ O @ | Remote System Explorer - RemoteSystemsTempFiles/I7ADTO6/QSYS.LIB/RSELABXX.LIB/QLONGSRCPF.FILE/PAYROLLFFF.RPGLI
M @it O Qur vl 4] e BRI . bl k5 e el =
| Quick Access el
4 Remote Sy... 8 i‘%‘- Team = O || §@ 8™ i RSE Getting Started | ## PAYROLLFFF.RPGLE 53 = O | g= out
& &) = Q:{') - Line 449 Column 11 Replace Browse
e PN | . RO S S JUE Y- S S - ST N -3t —
P [F PAYROLLG *pgm.rpgle 045608 hﬁ* - R + + + +
. IEIPA\"ROLLN.‘;:gm.rnge 245700 //* The following code verifies the delete request. The '-‘ﬁﬁ
» [4d PAYROLLPR."pgm.rpgle 845800  //* protect indicator *ING@ is first set on (equal to 1) v g
» &) PAYROLLG*module 045900 //* allow changes to existing data on a delete request. 2
b [53 COMPARE *file.pf-src 845000 i* 3
b [ DDSSRCZZ *file.pf-sre 046100 — Dcl-Proc ValidateDelete; >
»> @ EMPMST.flle.pf-dta 246200 *IN9B -~ *0N; >
» [5] EVFEVENT*file.pf-dta gjgigg Ij‘ IFDTIN?G;E . >
b 65 MSTDSPfile.dspf isplayError(9); >
65 MSTDSP2 *file.dspf baccoa | - ELSE;
) ~tie.osp 046700 ||~ IF NOT *INS@ AND ACREC - 'D'; >
> E] PRIMST*file.pf-cta 046808 DisflayError(18); b
" %DQCBLLESR_C”“E"DT_SM 847028 (- E"mIFDisr.!lm_.rErn::;r[ errCode Unsigned Integer (3,0) ) >
» [FQCLSRC "file.pf-sre 847100 |—  ENDIF; >
» [53 QCMDSRC *file.pf-src 847208 '— End-Proc; =
b (53 QDDSSRC *file.pt-src e47001 /- ) ]
"EQQLONGSRCPF.'ﬁIe.pT-src E:;gg; ;D’.-’l[l;spla;_er.rl-orEot the bottom of the screen with the giwe
CL-Froc 15 a rror;
Ch PAYROLLFFF.rpgle praY
b 55 QRPGLESRC *file.pf-sre >
» [ QRPGLESRCP file.pf-sre
» [55 GWFSRC *file.pf-src
3

[E REFMST*file.pt-dta

8 Remote System Details =] Tasks | [, Object Table 3% |C& commands Log & Terminals

(] Propert... &3 ] 4, Remote... = O || my IBM i: Filter ‘Library list' {7 Objects)
:'-.—:-'.:- L.” = || Name Type Attribute Text
Property Value B QSYS *LiB PROD-5YS SYSTEM LIBRARY
Attribute | SRC =, Q5Ys2 =LIB PROD-S5YS SYSTEM LIBRARY FOR CPI'S
Name PAYROLLFEE B QHLPSYS *LiB PROD-5YS
Number... 0 =4 0IISRSYS *LIR PRON-SYS Swstam | ibrary for Lsars
Source RSELABXX/QLOM...
Toxt p Command

Browse Replace 449 : 11

© 2016 IBM Corporation 20



DDS Designers on Mac

@ RDi File Edit Navigate
eC e
| i~ Q- 4

jﬁnzz]t e

& SRl

o

-
» [7 PAYROLLG *pgr
» [ PAYROLLN *pgr
* |# PAYROLLPR.p¢
&) PAYROLLG*mo
>[5 COMPARE *file.
- G5 DDSSRCZZ *file
- 5 EMPMST=file.p
[E] EVFEVENTfile,
p 6 MSTDSP*file.ds
» 6 MSTDSP2 *file.
> [E PRIMST*file.pf
» [53 QCBLLESRC il

)

v

o0

4
vl O

| MSTDSP.DSPF

= DSPSIZ(24 B0 *DS3) PRI
SELECT

EMPSEL

EMPMNT

PRJSEL

PRJMNT

RSNSEL

RSMNMNT

i

L

L

EEERET

Search Project Run Window Help

DDS Design - RemoteSystemsTempFiles/|7ADTO6/QSYS.LIB/RSELABXX.LIB/QDDSSRC.FILE/MSTDSP.DSPF - IBM Ration

&2 | B Te. = 0O

v P B . S o (o Efremote
E@ 18M i RSE Getting Started & PAYROLLFFF.RPG B msTDSP.DSPF 33 =
* Design page screen controls
© Design records Screen

Design screens
SELECT
(¥ el ]
R © 24x80
PRGO1 Time Reporting System MM/DD/YY
' Maintenance Selection HH :MM: 55
Enter an X beside the applitaticn y&u'wﬂnt to maintain
B Employee Master Maintenance
B Project Master Maintenance
Font size: 11 Grid: 2C

Design | Source | Preview

S| Properties 24 Ef urce Prompter [ Field Table

<my IBM i>RSELABXX/QDDSSRC(MSTDSP) . SELECT

1 Function Keys

Mame: SELECT

Type: DEFAULT

Keywords

I7ADTOE WDSCTEST: Connected

© 2016 IBM Corporation
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Application Diagram on Mac

@ RDi File Edit Diagram Navigate Search Project Run Window Help

[ NN ] Remote System Explorer - The application diagram for PAYROLLFFF. - IBM Rational Developer for i
=t e O Qur Pyl S : BRI I0 5 blv & Gv oo
.SF NS Text gl 1 & v v v v oG foe =% v

s

| e |ERermte System Explorer | [ DDS Design

H Remote Sy... 52 | %5 Team = B ||EgIBMiRSE Getting Started # PAYROLLFFFRPGLE B MSTDSP.DSPF |‘§5 PAYROLLFFF 53 ‘ Sl O &3 | = A8
., . WLLFRE =
& 2 g - | €% Palette [ =i
b [ PAYROLLG *pgm.rpgle heaao-
> [ PAYROLLN *pgm.rpgle '
: g:::gttgn.'pgdm;rpgle IRECORDREGUEST *._" VALIDATECHANGE
rmodule
> 53 COMPARE *file.pf-src
> [[3DDSSRCZZ *file.pf-src
> [E| EMPMST*file.pf- by
> E EVFEViNTl:i]: pfdt;ta VIOUSLYDEL ETEDRECORDREGUEST 4 Uaiinateann
b 6 MSTDSPfile.dspf
b 55 MSTDSP2 *file.dspf
» [l PRIMST file.pi-cta = =
» [y QCBLLESRC *file.pf-src | || ONeCPE eCIDATEDSLETE .0 " earessor
» F QCLSRC *file.pf-src
> 53 QCMDSRC *file.pf-src
¥ [ QDDSSRC *file.pt-src
T EMPMST. pf =
9@ MSTDSP.dspf —; VALIDATEFILETOMAMTAINSELECTION
0 PRIMST.pt
O REFMST.pf
O RSNMST. - =
. 2 o ja Remote System Details | Tasks Gq, Dbject Table &3 ﬁ'; Commands Log 5,@ Terminals g
L~ ! -
FES e @
[T Propert... 53 | [~ Remote... (i} my IBM ; Filter ‘Library list' (7 Objects)
F% ¥ ||Name Type Attribute Text
T ——— =, QsYS LB PROD-SYS SYSTEM LIBRARY
5 B Qsys2 “LIB PROD-SYS SYSTEM LIBRARY FOR CPI'S
“General  Name:  VALIDATEDELETE | || ZhQHLPSYS “Le PROD-SYS
Type: PROCEDURE
= /P P Command

© 2016 IBM Corporation 22



Mac OS Xv10.11

e Limitations:

— ILE RPG source information support in Application Diagram is limited and
IS restricted to being invoked from within the Editor (not from the RSE
view) when ILE RPG live outline view is enabled

— Invoking help from the editor might launch a new browser tab each time
— No bidi support in Screen/Report Designer

» Without native Mac-specific code
— syntax checker is not available for ILE/OPM COBOL, ILE/OPM RPG

— program verifier is not available for ILE/OPM COBOL, ILE/OPM RPG,
DDS

— ILE RPG static outline view (the 'Update the Outline view when text is
changed in the editor' preference on the ILE RPG preference page is not
checked) shows 'An outline is not available'. Use the live outline view
(ensure the preference is checked).

— Unable to generate PCML from RPG or COBOL Source

o creating an IBM i web service from RPG or COBOL source is not
supported

© 2016 IBM Corporation 23



Differences on Mac

» Mac is different and RDi is mostly doing it the Mac way
Window->Preferences menu item moved to RDi->Preferences
Help->About menu item moved to RDi->About

ACS emulator is provided instead of Host Connect emulator

Ctrl+Space keyboard shortcut might conflict with system shortcut for
Spotlight and not invoke content assist in the editor. Workaround:
redefine system shortcut for invoking Spotlight or redefine Eclipse shortcut
for invoking content assist.

Other keyboard shortcuts are not the same as documented

© 2016 IBM Corporation

O

©)
©)
©)

Format RPG is Cmd+Shift+F instead of Ctrl+Shift+F
Delete line is Cmd+Backspace instead of Ctrl+Backspace
Save is Cmd+S instead of Ctrl+S

Insert mode not there by default, but can click on ‘Replace’ in editor
status line to toggle mode, or can map a key

Refresh Cmd+F5 conflicts with voice over

24



Differences on Mac

» Keyboard shortcuts detailed:

Shortcuts for Windows and Apple computers available in Rational® Developer for i.

e General

s Editing

e Editor navigation

e Code block highlighting

e Debugaing

=1 Note: On Apple systems, the shortcuts below that specify using the Fn key may be different depending

on the preferences that you have set for your keyboard. For example, in OS X, if you have selected the
keyboard preference vse all F1, F2, etc. keys as standard functions keys, then you may be

able to omit using the Fn key as part of the shortcut. For example, the default shortcut for F1 Help is
Fn+F1. But if you have selected the preference to use the keys as standard function keys, then you can
simply press rF1 instead.

Action Windows Apple

General

Copy Ctrl+C Command+C

Cut Ctrl+X Command+X

Paste Ctrl+Vv Command+V

Undo Ctri+Z Command+Z m

© 2016 IBM Corporation 25


http://www.ibm.com/support/knowledgecenter/SSAE4W_9.5.1/com.ibm.etools.iseries.rse.doc/topics/keyboard_shortcuts_platforms.html

Dependencies on Mac

* Install issues
— After uninstall, a file might remain in the product install folder. It can be

deleted and then the product install folder can be deleted.

'‘Launchpad can't be opened because it is from an unidentified developer’
message appears. Use Ctrl+click or right-click and select Open to be
prompted if you want to open it.

On the product image, IBM Installation Manager's Install.app or
Userinst.app might give an error message saying they are damaged.
Instead, open Terminal and run the corresponding script.

» Other product dependencies

Limitations of Rational Application Developer components included in RDi
Update Notifier is not supported

Other products bundled with RDi might not support Mac OS X 10.11 such
as IBM Data Studio

IBM Rational Team Concert Integration for Rational Developer for |
extension requires IBM Installation Manager install of Rational Team
Concert Client which is available from version 6.0.3.

© 2016 IBM Corporation 26



For more info

» Detailed blog post on
— How to install on Mac
— What function is supported
— Workarounds for limitations

https://www.ibm.com/developerworks/community/blogs/4977 3f8f-a20d-4816-

86f2-
44a2d862dbcl/entry/RFE13454 Mac OS X v10 11 support in RDi 9 5 1

© 2016 IBM Corporation

27


https://www.ibm.com/developerworks/community/blogs/49773f8f-a20d-4816-86f2-44a2d862dbc1/entry/RFE13454_Mac_OS_X_v10_11_support_in_RDi_9_5_1

Feedback — Mac support

* Which limitations on Mac do you feel need to be addressed before you could
deploy Mac in your shop

We don’t have Mac in our shop

We can deploy with the stated limitations

We need Web Services/PCML generation support before deploying

We need Application Diagram from Remote Systems Explorer selections
We need Syntax Checker before deploying

We need Program Verifier before deploying

We need all install issues addressed before deploying

There is another limitation that | need addressed before deploying

© N O O A~ WDdPE
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RDi platform support
* Added Mac OS 10.11

— We will likely support the latest Mac OS at the time of release.
* Linux

— Likely to drop support for SUSE in future release

Red Hat (RHEL) 6 64-bit
RHEL 7 64-bit
SUSE (SLED) 11.0 64-bit
SUSE (SLED) 12.0 64-bit
Ubuntu 16.04 LTS 64-bit

* Windows
— Likely to drop 32-bit Win 7 and 32-bit JDK on 64-bit Windows

8.1 Enterprise Xx86-64 32,64
8.1 Professional X86-64 32,64
7 Enterprise X86-32 32

7 Enterprise X86-64 32,64

© 2016 IBM Corporation
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Windows support

8.1 Enterprise
8.1 Professional
7 Enterprise

7 Enterprise

7 Professional

7 Professional

7 Ultimate

7 Ultimate

8 Enterprise

8 Professional

Server 2012 R2 Essentials
10

© 2016 IBM Corporation

x86-64
x86-64
x86-32
x86-64
x86-32

X86-64
X86-32
X86-64
X86-64
X86-64
X86-64
X86-64

 Likely to drop 32-bit Win 7 and 32-bit JDK on 64-bit Windows

32,64-Exploit, 64-Tolerate
32,64-Exploit, 64-Tolerate

32

32,64-Exploit, 64-Tolerate

32

32,64-Exploit, 64-Tolerate

32

32,64-Exploit, 64-Tolerate
32,64-Exploit, 64-Tolerate
32,64-Exploit, 64-Tolerate
32,64-Exploit, 64-Tolerate

32,64



Feedback - Platform Support

« We want to know if we are supporting the client platforms that your shop
needs.

All my client platforms are supported, focus on other enhancements

| still need 32-bit Windows support

| still need 32-bit Linux support

Your Mac support has to improve before | can use it

Forget specific operation systems, | want to edit in a web IDE like Orion
Hey your forgot about the client platform that my shop is using

S o
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Kerberos support

 Single Signon: No longer need to provide logon credentials when connecting to
IBM i through RDI

|t)rpefi|ter text Authentication

[ Help

I- 1 Projects
IMP
Install/Update Authentication options | Kerberos
Java IBM i User ID and Password
Java EE Kerberos Parameters

JavaScript [+ Automatically determine parameters for Kerberos

Jython
LPEX Editor o | HoPe

Model Validation Realm | RDP.LOCAL
Muodeling
Plug-in Developrment

Select the primary authentication type to be used

Profiling
Remote Systermns
Communicaticns
DataStore
[ Debug
File Cache
Files
4 IBMi
Authentication
Cache
£ m

@ | ok || Cancel |

| Restore Defauhs| | Apply
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Kerberos documentation

o http://www.ibm.com/support/knowledgecenter/SSAE4W 9.5.1/com.ibm.etools.i
series.rse.doc/topics/kerberos setup ovr.html

Kerberos authentication requires configuring several resources. Server configurations are usually handled by a system
administrator. This topic provides an overview of the setup requirements.

=1 Note: If Kerberos authentication is already a standard practice in your business, server and your personal
computer configurations may already be in place. If this is the case, you may only need to Configure Kerberos
authentication in the IDE to work with Kerberos authentication. Consult your system administrator for guidance.

1. Setup a Kerberos Key Distribution Center (KDC) server. For more information see:
https://social.technet.microsoft.com/wiki/contents/articles/12370.windows-server-2012-set-up-your-first-
domain-controller-step-by-step.aspx.

2. Configure the IBM i server for Kerberos authentication. More specifically, EIM (Enterprise Identify
Mapping) needs to be configured to work with Kerberos authentication:

a. Configure LDAP on IBM i. For more information see: IBM Tivoli Directory Server for IBM i (LDAP).

b. Configure the network authentication service. For more information, see the section Configuring
network authentication service on the IBM i platform (steps 1-4) at Configuring network authentication
service.

c. Configure single sign-on on IBM i. For more information see: Single sign-on.

3. Configure the workstation that the IDE is installed on. For more information see: Configure your operating
system security policy.

4. Join your workstation to a Kerberos domain if domain authentication is used in your environment. Consult
your system administrator for details about joining a Kerberos domain on your network. For general information
about how to join your computer to a domain, see: How to Join Your Computer to a Domain.

5. Configure the IDE to work with Kerberos authentication. For more information see: Configure Kerberos
authentication in the IDE.

© 2016 IBM Corporation 33


http://www.ibm.com/support/knowledgecenter/SSAE4W_9.5.1/com.ibm.etools.iseries.rse.doc/topics/kerberos_setup_ovr.html

Kerberos issues ***Fixed in 9.5.1.1***

» Users have reported some issues using Kerberos setting in RDi. We are
working on the issues.

— Registry key on Windows

o Java JAAS library requires access to Windows Local cache to
retrieve kerberos tgt. If ‘allowtgtsessionkey’ in registry is unset (either
O or doesn't exist), JAAS will a tgt with empty session key (all zeros),
which will cause "KrbException 31 - Integrity check on decrypted field
failed.

The following command can be used to query the key
REG QUERY HKEY_LOCAL_MACHINE\System\CurrentControlSet\Control\Lsa\Kerberos\Parameters /v
allowtgtsessionkey

— Debug connection does not use Kerberos setting
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IFS synchronization support for local projects

* RDi has powerful support for many different types of projects
— Web (Html/Javascript/CSS)

— Java Etc. etc.

« Wouldn't it be cool if these could be deployed to the IFS at the click of a button?

© 2016 IBM Corporation

[t5 Project Explorer & l

EE B

[

E‘.

W

b

G i

x

r?ﬁ'

o

New 4
Go Into

Show In Alt+Shift+ W
Copy Ctrl+C
Copy Qualified Name

Paste Shift+Insert
Delete Delete
Build Path 4
Refactor Alt+5Shift+T?*
Import b
Export »
Refresh F5

Close Project
Close Unrelated Projects

O ||E=IBM i RSE Getting Started [ *index.html &2 ISA Master.css

N =ETIEE

L

HTML>

"stylesheet” href="theme/Master.css" type-
ex</title>
-equiv="Content-Type" content="text/html;

Remote Reconciler 4

%, Enable Remote Support...

Transform

Validate

Show in Remate Systems view
Add SQU Support...

Profile As 4

A TZ2aT sl

plit

ib Servers | Properties &2 IE Quick Edit B Cons




Remote Reconciler can now be used to synchronize to IFS

@ Enable Remote Reconciling |LX§

« A project can be associated with a Remote Projects Location
Remote COnteXt @ Remote location must be specified

o Th |S |S an I FS d | reCtO ry th at Wl ” be You must specify a common location on the remote machine under which all imported projects’

remote contents will be created and subsequently synchronized with. You must specify a commaon
Synch ron Ized Wlth the |Oca| Ecl I pse location on the remote machine under which all imported projects’ remote contents will be created.
If the projects you selected for import do not share a common remote location you should only
H select projects with a common remote root. You can later import other batches of projects with a
p rOj eCt- different common remote root by invoking this wizard again on those projects.

» Optionally this can be done on demand

T

Or eve ry tl me a fl Ie IS Saved ] Specify common location for the selected project:

Common remote root: | @ Browse For Folder w
File synchronization: Select a folder
(@ Work with local copy of files and| | Connection: ltoronto V] lNew...]
PR /home/REINHARD/tmp
1l Aral laration ic 3 manntad fald
2 » [ RDPDEMO o
- > [ rdptest
Q) "

4 (= REINHARD
» [0 CodeCoverage

T —— |
> [ java
[%] Problems 4% Servers |
i > [0 nodedw
» [0 nodejs_s3

Web Preview Server [defaultSen|

| » [0 optum_demo
[AUDIT ] CWWKZeea1I: 4

L

]

[AUDIT ] CWWKT@®161: + © payrollProject

[AUDIT ] CWWKZOOO1I: +|8 tmp =
[AUDIT ] CWWKF@@12I: § » [ RLSAWYER
[AUDIT ] CWWKF@@11I: | - 3 RSWOFFOR

- 3 SANSU -

RN m

Cancel
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Remote Reconciler view can be used to synchronize

« Can pushto IFS, or pull from IFS
« Can compare with IFS
* Ignore files that shouldn’t get synchronized, etc.

||lbl‘lll\l"lLI’UllTl 1days Rt
<IDOCTYPE HTML> ‘&, Refresh Remote T
= <html>
= <head> LiEE It I
<link rel="stylesheet" href="theme/Master.css" type="text Show In * Imit Button -
<t1t1e>1ndex<f’.c1t1e> Push To v | %y (toronto) web
<meta http-equiv="Content-Type"” content="text/html; chars
</head> Pull from (toronto) web %y All Contexts
<body> Launch , feral Button
<form:> on
‘ oA T I AT - - oA CDmparE Wlth ' - .
Design|50urce Split @ Mark as Merged [ - O
- # Ignore Inot available
[& Problems  # Servers  |&, Remote Reconciler &2 | Properties & Col ¢  pelete
Properties
Resource Project Type Status Remote Location
a B web Local Local Only (toronto) /home/REINHARD/tmp/web
B apt_generated Local Only
4 B WebContent Local Only
b B WEB-INF Local Only
B src Local Only
<« | 1 3
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Multiple Remote Contexts can be defined

« This can allow deploying to multiple machines/IFS directories

[t5 Project Exp... 2 |J|ﬁ Remote Sy... = 0

= IBM i RSE Getting Started ‘@ index.html 2 ‘ S| Master.css

B -

—+l

—

i

sozafeo|Bol¢|D

Device: Standard

b

a [ e
2 New
a2 Go Into

; Show In

Copy
Copy Qualified Name

[} Paste

X Delete
Build Path
Refactor

b

a Import
Export

Refresh
Close Project

69

Close Unrelated Projects

Remote Reconciler
Remote Contexts

%

Transform
Validate
Show in Remote Systems view

Add 5QU Support...
Profile Ag
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Alt+Shift+W »
Ctrl+C

Submit Query

Shift+Insert
Delete
3

Alt+Shift+T »

3

3

F5

LIPS S | 1 LML [l NN FAT L

v B Synchronize with (demo server) java-hello

Push/Pull Settings
%, Push to (demo server) java-hello
#3  Pull from (demo server) java-hello
@  Mark as Merged

Show In

t—tone="text/css">

-~

L
S0
-

®

s

T F I Z I o4

-

EJ Push on Save
k4l Push to All Contexts

¢’ Pull on Remote Update

& Configure Automatic Remote Refresh...

’ Isubmit")

r P>

I
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Detailed blog on how to use IFS synchronization with Java

o https://www.ibm.com/developerworks/community/blogs/49773f8f-a20d-4816-

86f2-44a2d862dbcl/entry/RFE45970 IFS project support using RDiI 9 5 1

| type filter text | Remote Contexts fryro v >
’ Rei_;ource Standard Local Project with Push Synchronization
Builders
Java Build Path Contexts
Java Code Coverage Name Host Path
> Java Code Style 2% (IBM i Development Machine) .. IBM i Developme... /home/wdsctest/myifsjavaproject
> Java Compiler
> Java Editor
Javadoc Location
Project Facets
Project References
Refactoring History
| Remote Contexts| " = .
Run/Debug Settings -_
Task Tags l Create... l l Add... l l Change... ] [ Remove l l Move Up l l Mave Down
» Validation
[¥] Push on save
@) to the current context
() to all contexts
Pull on remote update
Push on build
) ok || cancel
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ILE RPG live model improvements

Outline view, references, hover, hyperlink 4. O-Specs: qualified indexed arrays

1. Control Statements section 5. O-Specs: named constants
2. Output Statements section 6. I-Specs: qualified indexed arrays
3. Exception Output section 7. Indexed indicator array references
# PAYROLLFFGR.. A arpgle A aarpgle 4 aaarpgle 4 aaaarpgle |/ *aaaaarpgle &2 | = 8 || 8= outline &2 -
Line 17 Column 39 Insert 62 changes % B < 3
..... Ouevvvenennnn. .NOINO2NB3Field++++Betst+YB. End++PConstant/Editword/DTformat++Comments++++- type filter text
ctl-opt OPTION(*XREF): -
dcl-ds qu qualified; Control Statements -
named int(1@}; “Tl | 4 (& Global Definitions
end-ds; O Files

dcl-s arr int(18) dim(%size(gu.named));
dcl-f file disk(28) usage(*input : *output);

- U@ Data Structures

: i— Fields
dcl-c output constant ‘Hello world!';
= . [@ Constants
Ifile ns 6 4 [ Indicators
I I 2 4 @arr(qu.named) | » [&] *INLR
/7 4[5 *INO3

C write expl ® 18
‘ SETON LR 3‘ . @y Prototypes

: s 4zl E tion Qutput
ofile e expl %L Exception Outpu
0 output_constant 4 = expl
0 ar‘r‘(qu.natﬂed) ® 12
0 ‘?J(EB) |named Integer {IU.UJ| i (= Input Statements

[z Qutput Statements .

a Main Procedure




ILE RPG OQutline subset to referenced variables

# arpgle  # aarpgle [/*aaa.rpgle £ ‘/aaaa.rpgle # #aaaaarpgle s = O
Line 16 Column 1 Insert 2 changes -
I...+....1....+....2....+....3....+....4....+....5....+....6....+....7_

dcl-f xprodcat; // lots of fields dragged in but only 1 used
& Jcopy moredefs // imagine how much clutter is being included
dcl-ds result; // lots of subfields that are not referenced
lots int(3);
of int(3);
unused int(3);
vars int(3);
that int(3);
clutter int(3);
the int(3);
namespace int(3);
referenced int(3);
END-DS;

referenced = 1;

o= Outline &2

NSRS o

B= Qutline 2 IS 2T

type filter text

4il# Global Definitions

4|

> [ Files
» L@ Data Structures
4 [ Fields

[ CAT : Packed Decimal (9,0)

2 PROD : Packed Decimal (10,
[0 TITLE : Character (64)

[0 PHOTO : Character (64)

I PRICE : Packed Decimal (12,
[ 1ots : Integer (3,0)

[0 of ; Integer (3,0)

& unused : Integer (3,0)

[ vars : Integer (3,0)

[ that : Integer (3,0)

& clutter : Integer (3,00

[ the : Integer (3,0)

1 |

|3

[ namespace : Integer (3,00
- 5 referenced : Integer (3,0) -
P

d

type filter text

4 [ Global Definitions
[ Files
- [g Data Structures
4 — Fields

. [T referenced Integer (3,0

Main Procedure

« 11th highest voted RFE 12353 — only show those definitions in outline view that

are actually referenced in the source
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ILE RPG Language Sensitive Help for embedded SQL

Hit F1 to get reference information on the SQL command under the cursor

S e L

oo | ine (C.) Chen
Exec SQL » & Updstatinfo = ll(i0.K.) Mcknight
DECLARE CS_Account CURSOR FOR 4 UpdMotes nd
SELECT * - B Parameters Jlimpson
FROM ACCOUNT » [ Local Definitions (Z.) Jin
WHERE BUILDDATEID = :Txyr; ® 139 (D) Littiejohn
(=) HElp - IBM Rational Developer for i ¢ - E@g
- — I
Sedch: | |E Scope: All topics
Colltents &~ - elgl o co @l E&a
B CREATE TRIGGER « IBM 7.3 > Database > Reference > SQL reference > Statements

& CREATE TYPE

B CREATE TYPE (array)

& CREATE TYPE (distinct)

B CREATE VARIABLE

B CREATE VIEW

£ DEALLOCATE DESCRIPT

& DECLARE CURSOR

B DECLARE GLOBAL TEMF

& DECLARE PROCEDURE [
B DECLARE STATEMENT
B DECLARE VARIABLE

& DELETE

3 & DESCRIBE

e MY CmnmTRE AL INemn

m

4
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[amy]

DECLARE CURSOR
The DECLARE CURSOR statement defines a cursor.

Invocation

This statement can only be embedded in an application program. It is not an
executable statement. It must not be specified in Java™.

Authorization

No authorization is required to use this statement. However to use OPEN or

| FETCH for the cursor, the privileges held by the authorization ID of the

statement must include at least one of the following:

* For each table or view identified in the SELECT statement of the cursor:
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ILE RPG Automatic Content Assist is available as a preference

—

(%) Preferences e e - I E@g

Content Assisﬂ Content Assist =T 4 v -
4 Remote Systems o
4 Remote Systems LPEX Editor Auto Activation
4 IBM i Parsers [¥] Automatically make suggestions
4 [LE RPG Auto Activation delay (ms): 500

Content Assist
Il 4 Report Design

Prompt when these characters are inserted: %.

# *TIRFDEMOL... 53 | 4 ZZZLRPGLE 4 *RFDEMOL.RPGLE . = B || 5= Outline 22 1% B &
Line 7 Column 13 Insert 2 changes Bl 4 L& Global Definitions
..... FFEE—FGFM—Hﬂ—FFH—l—H—FFH—l—FFFFFFFH—l—FFFFFH—FFFFFH—FFH—l—H_ 4 g Data Structures
aee1l1a dcl-ds color qualified; 4 [J color: QUALIFIED
286111 red int(1l@); )
BBE112 green  int(5): 1 red: Integer (10,0)
BEE113 dcl-subf blue  int(5); 1 green : Integer (5,0)
000114 END-DS; T [ blue : Integer (5,0)
aaa117 & 7
& @eells x = color.] Main Procedure
RNF@632E T[ [ ed red |
aealds 'I—lgrEEFI
RMF5587E A int(10,07
Hblue Int(10.0)
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ILE RPG Additional Parameter Info on Content Assist

dcl-pr calcTax;
name char(18@);
salary zoned(8:2);

D F

end-pr;
referenced = calcTax( 'Tim Rowe'
B &) Tasks  [m Object 1

© 2016 IBM Corporation

¥ calcTax

h

calcTax

EXTPROC('CALCTAX)

(

name char{10)

salary zoned(8,2)

- i



ILE RPG Show block nesting now shows containing
Procedure / Subroutine

Ctrl-Shift-O is
invoked on a line
that is not a
control flow
statement, it will
display nesting for
the current
subroutine or
procedure and
also show the
name of the
current subroutine
or procedure in the
editor message
line.

© 2016 IBM Corporation

Line 87 Column 1 Replace 2 changes
5T [ TR, ) M <N S« N S

005704 PRJAPL = *BLANK;
00580 RSNAPL = *BLANK;
00590 //
00600¢ //  Write the SELECT format to disj
006104 //
00630« DoU not *IN6O;
006301 //  IF the general error indicatc
00630 //  program continues to loop
006404 Exfmt SELECT;
00650 If *INKC = '1'; // F3 = end of jot
006604 f Return;

00670 Else;

00680( L ValidateFileToMaintainSelection|
00690« EndIf;

00740 EndDo;

00750

00760¢ The application selection fields fi
00770 tested and the program will branch
007304 I that application.

00870 [ Select;

00880 When EMPAPL = 'X';

00890 CallP EmployeeMaintenance();
00900

009104 |r When PRJAPL = 'X';

AACIAL

< |

I

ainMenuScreen

d CSVID. DinssrdMaintanmarcl s
‘
»
|

IBM Knowledge Center explanation

‘ type filter text

4 (@ Global Definitions
» [ Files
> = Fields
- [@ Constants
» 3 Indicators
» s Prototypes
{& Main Procedure
4 &g Subprocedures
» & MainMenuScreen
> @ ReasonMaintenance
> @ EmployeeMaintenan
v & ProjectMaintenance
i & isAddNewRecordRe(
» @& isAddPreviouslyDele
1 & ValidateFileToMaint:
» @& ValidateActionCode
& ValidateAdd
» @ ValidateChange
> & ValidateDelete
1 & DisplayError



http://www.ibm.com/support/knowledgecenter/SSAE4W_9.5.0/com.ibm.etools.iseries.rse.doc/topics/tblock_nesting.html

Syntax Errors as Annotations

» Syntax checker errors used to be shown a pink lines inserted into the source

DCL-DS *N;
DCL-SUBF select CHAR(10);
name CHAS(1@);
RNF3308E Keyword name is not valid; the keyword is ignored.
END-D
RNF5347E An assignment operator is expected with the EVAL operat

* Now you can choose to show them as annotations instead

Parsers IBM i Parsers
4 |PEX Editor
Parsers
4 Remote Systems
4 Remote Systems LPEX Editor

See 'Parser Associations' for associating a document type with a parser.
See Parser Styles' to change colors for tokens in individual parsers.

IBM i Parsers
[ Add signature to changed lines for RPG/400, ILE RPG and DDS parsers
Show Block Nesting -
[ Display syntax check messages as annotations
DCL-DS *N; DCL-DS *N;
DCL-SUBF select CHAR(10); DCL-SUBF select CHAR(10):
o name CHAS(10); Hover X |RNF33[}EE Keyword name is not valid; the keyword is ignored.
norenes Bddeac s AUADOER T -SIAF addrecs (HARTIGY -
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Comment / Uncomment actions in CL and DDS

« Becomes
Jf*
f:t

DCL
DCL

DCL
DCL

Ctrl-\ will uncomment

AR(&CARRY)

VAR(&CLIENT) TYPE(*CHAR) LEN(3)
VR (&CARRY)

TYPE (*CHAR)

=

DCL VAR(&CLIENT) TYPE(*CHAR)RSIIEN

DCL VAR(&CARRY) TYPE(*CHAR)
Comment Ctrl+/
Uncomment Ctrl+Y,
Add Block Comment Ctrl+Shift+/
Remove Block Comment Ctrl+Shift+y
Show Block Nesting Ctrl+Shift+0
Select Block Ctrl+M
Jump To Block End Ctrl+Shift+M
Hex edit line Alt+Shift+H

© 2016 IBM Corporation

Syntax Check Selection

Save

Cut
Copy
Paste
Select
Selected
Deselect

Filter view
Show all

Source
View

Ctrl+5

Ctrl+X
Ctrl+C
Shift+Insert

Alt+U

Ctri+Alt+A

Ctrl-/ will comment each individual line selected
VAR(&CLIENT) TYPE(*CHAR) LEN(3)
TYPE (*CHAR)

Ctrl+Shift+/ will block comment only the selection

DCL

LEN(3)

*/
LEN(3)*/

VAR(&CLIENT)

TYPE(*cHAR) INEIIIETENE/

a7



Code Coverage — Filtered File Report

 After running code coverage, open as a Filtered File report option is available

M Remote Syst... & Tasks [# Object Table € Error List & Commands L. & Remote She & Terminals &’ Remote Sear...
Name Status Coverage Level Analyzed Date ’
4 [ Compiled Code Coverage Workspace Results
Eli PAYROLLFFF_2016_11 28 135554 0778 0 SRS ine Nov 28, 2016 1:55:54 PM
Elj PAYROLLFFF_2016_07_12_131109_0869 Open | oy 129016 1:11:09 PM
€l PAYROLLFFF_2016_07_11_153614_0973 projectr  OPenAs e il et 6 3:36:14 PM
£l RBCANNFIC_2016_07_11_112937_0704 Compare 4 _ Filtered File Report. 611:29:37 AM
Eli PAYROLLFFF_2016_07_11_112759_0067 employe Compare As li, Workbench Report 6 11:27:59 AM
Ju JUnit Code Coverage Workspace Results 4 Add Result Location £ HTML Report
7 Java Code Coverage Workspace Results I | Rename 0 w| PDF Report
¥ Delete.. Delete
i Export.
B Properties... Alt+Enter

» Specify a filter string and the report will show code coverage results for lines

that match the filter string

Results

— File report

Name Coverage

- B PAYROLLFFFRPGLE [ 3Jg% |

Results

Name Coverage

— Filtered report - [ PAYROLLFFF.RPGLE
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95

Lines Covered WUncovered Lines

6

Lines Covered WUncovered Lines Total Lines
243

Total Lines
10
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EGit is now available on the base RPG/COBOL package

« Gitis a very powerful and free source control system that is now available on
IBM i

« EGitis a free user interface for Git that is integrated with Eclipse.

» RDi ships this for free with the base package (before this release it was
shipped with the Java Modernization package) but better to install from Eclipse
Marketplace (via Help menu)

) IBM Installation Manager et .

Install Packages

Select the features to install.

Insta Prerequisite Licenses Location Features Summary
Features License Key..
4 ) IBM® Rational® Developer fori 9.5.1.0

RPG and COBOL Tools Permanent
- Modernization Tools, Java Edition Permanent

Eclipse Git Team provider
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Why ACS and which ACS

* ACS is being invested in heavily by IBM and will continue to see
enhancements.

— The emulator is best of breed

— There is now SQL Performance Center

— There is integration with web-based Navigator for i
— Visual Explain is available as of 1.1.6

— Itinstalls and runs anywhere (using Java)

« RDi will launch the version of ACS you already have installed if it is recent
enough — and you have access to all its other functions

(it is free from

)

« If ACS is not installed, RDi will launch a copy shipped with RDi. As of RDi
9.5.1, the bundled version of ACS is 1.1.6
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http://www-03.ibm.com/systems/power/software/i/access/solutions.html

Run SQL queries from the selection in your editor

» Access Client Solutions (ACS) now has Run SQL Support. RDi provides tight
integration with it.

» Select the SQLRPGLE source in the editor
* From the Source menu
— ‘Launch Run SQL Scripts’

[Source] Compile(G) Navigate Search Project Data Run Window Help

New Yl i+ @ Activity: Other Activity v B
Prampt F4
Syntax Check All
- clle  # *PAYROLLFFF.. # asqlrpgle [/ *DUS
& Ver!fy Curl+Shift+V o 317 Column 35 Replace 11 changs
®4 Verify (Prompt).. +1+2+34
I* Visualize Application Diagram from f57rel
Convert All To Free-Form where b.rta
. a.rpre
Select Format Line...
Show I?dentation Exec SOL
Show fields insert into empRome
Format Ctrl+Shift+F select EMPNO,
/COPY Member ’ eName,
- eDept
L h Run SQL Script o
aunch Run SQL Scripts S
ILE RPG Help 4 eNHrs|
from EMPMST e
Remove Messages where e.locn — 'ROME'R
Refresh
<" Refresh Outline View Ctrl+Shift+F5 If SQLSev > '02°';

Work with members...

LogMsg('":@: "Error ' + SQLSTATE +
© 2016 IBM Corporation ¢ Library list

" on F57rel in Startup');

CRINMTELC -


http://www-03.ibm.com/systems/power/software/i/access/solutions.html

Run SQL queries from the selection in your editor

b5 C\Users\IBM_AD~ l\AppData\LocaI\Temp‘ﬁBSlSﬁﬁMS}'ﬂ 194... E

Eile Edit View BRun Options Connection
eS|+ RR(FPFDO |

1 select empno,
ename,
edept,
enhrs
from empmst
where elocn = 'Rome"' ;

« Launches the ACS Run SQL
Statements

 Connects to the database on the
system that the member was on

« Some editing my be required to
replace RPG variables with literals,
etc.

L= TS R R Y I o)

o A caao s ol . LIL

Connected to relational database M10GBEEP on
emboxl.demos.ibm.com as REINHARD - =
836359/QUSER/QZDASOINIT

Messages

Connected to relational database M100BBSP on emboxl.demos.ibm.com as REINHARD - 8363...
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Configuring Run SQL Statements for unqualified file names

in SQL

« However RSS does not set up the same LIBL as in RSE

* You can do this using one of the following commands:
cl:chglibl lib1 lib2 lib3

C|Ca|| SEtmy|Ib|, ‘l set schema reinhard;|

2 select empno,

set schema prodlib;
* You also should then set the naming to *SYS

B C\Users\IBM_AD~ \AppData\Local\Temp\rdi3515666437

File Edit View Run Options |Connection

BFE ¢ 2R FFD

1 set schema reinhard;
2 3elect empno,

3 EName,
4 edept,
5 enhrs

& from emomst

© 2016 IBM Corporation

Connect to Database..
Reconnect
Disconnect

JDBC Settings...

&) JDBC Setting

5

Systéam Format |

Packagel Per‘Formancel Languagel'Traﬁslation | Dthmr|

Maming conventio
Timse

Separator: |. (pe

Date
Format: W
Separator: |- {da

Decimal separator: |5QL (*SQL)

n:[,5QL (*5QL) h

Format: ihh.mm.:ﬂs (*IS0) vi

rind] -

mm-dd (%150} ¥

sh) -



Select Run All and see the results

* Select Run All either from the
toolbar or menu

e The results are shown in a tab on {8 c\usersuBM_AD~1\AppData\Local\ Temp\rdi351566643752194... | = | [=] [ |
the bottom File Edit View Run Options Connection
h b h h | s + 2R |20 0@

The Messages tab shows the log || o

of commands and results i[5 7 Tonane,
E izt
i [ B from empmst
1 7 where elocn = "ROME' »

> set schema reinhard ]
1 EMPNO ENAME EDEFT ENHRS
42154 PATRIZIO 2DFAD 40.0

Statement ran successfully (202 ms)

> select empno, ehame, =dept, enhrs from emprst ] Done. 1 rows retrieved.

where elocn = '"ROME' - Messages| select empno, ename, edept, enhrs from empmst where elocn = 'ROME'

Connected to relational database M100BBSP on emboxl.demos.ibm.com as REINHARD - 8363...
Statement ran successfully (1,686 ms = 1.686 [ — ————— J
sec) i

Messages | select empno, ename, edept, enhrs from empmst where elocn = 'ROME'

© 2016 IBM Corporation



Run SQL Scripts can be launched at any time

As on 9.5.1 the RSS can be launched from
the Objects Subsystem and is not restricted
to SQLRPGLE members

© 2016 IBM Corporation

4 Remote Systems 2 ‘ %5 Team = B ||B% Demosen
£ 8| @l B|ls - Line
+ 4 New Connection = S
- B Local of
4 E8 Demo server unu
A Ef Ohierts var
. B C Mew 4
- EZ IR Go Into
- B8 Jo Go To i |
% 5 B .
’ E I @8 Open in New Window '
> ®ESt @ Show in Table
i
0¥ Ql & Monitor
4 §& Toro, # Open Member.. Ctri+AIt+Q |
3
4 @ 8] i
8 " Work With L
> g
. 3% &1 Refresh F5 |
> 4 Sart
4 B |
Disconnect
Clear Password |
Change Password...
X Release Interactive Job
Verify Connection...
Ill = Properti Remote Servers 3
Show Log |
Property Run Command... :
C
onnec Host Connection Emulator
Name L h Run SQL Scripts
aunch Run
Numbe B
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Visual Explain through ACS

B Untitled* - Run SQL Scripts - EMBOXLDEMOS.IBM.COMM1008... | (5] [ Sl

Eile Edit View Run E‘v’isualEprain] Options Connection

BEe| d =

1 SELECT *
FROM MyTabl Explain While Running Cir

WHERE Salar]

Explain
Run and Explain

Qptions

IBM i specific SQL
guery optimization

© 2016 IBM Corporation

Ctrl+E
Ctrl+U

[ NN ) Visual Explain - common1.frankeni.com(COMMON1)
File View Actions Options

Hﬂ\"‘ﬁ BRI o BT ON B serch  Ignore Case

Attribute | Value |
Query Engin... SQE
TimeInfor... [ |
Timestamp... 2016-09-...
Statement S... 2016-09-...
Statement E... 2016-09-...
Total Estim... 1.956
Actual Run...| |
Optimizatio... 2
Run Time (... Not Available

s £
Sorted List Scan  Temporary Sorted List User-Defined Table Function

S O... Not Available
Statement F... Not Available
S C... Not Available
With TOP_CONSUMERS (JOB_NAME, MEMORY POOL, AUTHORIZATION NAME, FUNCTION TYPE, Function,
TEMPORARY_ STORAGE, RANK)
As (Select JOB_NAME, MEMORY POOL, AUTHORIZATION NAME, FUNCTION TYPE, Function,
TEMPORARY_STORAGE, RANK()
OVER (Partition By MEMORY POOL Order By TEMPORARY STORAGE Desc)
From Table (QSYS2.ACTIVE_JOB_INFO()) X
Where JOB_TYPE <> 'SYS')
Select JOB_NAME, MEMORY POOL, AUTHORIZATION NAME, FUNCTION TYPE CONCAT '-' CONCAT Function
As Function, TEMPORARY_ STORAGE From TOP_CONSUMERS Where RANK In (1,2,3,4) Order By
MEMORY_ POOL Desc
Nleicpaigodas  Optimizer Messages
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« Customers requested better spool file
management.

« ACS already contains robust spool file

Launch Printer Output from ‘Spooled Files” subsystem

support

« Now there is a convenient way to get from

here to there

4 Remote Systems hs. Team
£ 8| | B % = ||curent host conn

- < New Connection

+ Ef Local

B || B PublicDemolB

] -

4 [ Public Demo IB
4 gt Objects

» Ba Work with

- 35 Work with

- 15 Work with 8

& Library lis
- & User libra
- @ Code Cov
> B Code Covi
& LAB Data
> g¢ embedde
- B Commands
» B IBMi Context
> & Jobs
- & IFS Files

» &% Spooled File:

New

Go Into

GoTo

Open in New Window
Show in Table
Monitor

Refresh
Sort

Disconnect
Clear Password

Host Connection Emulator

Launch Printer Output

Properties

b

F5

F¥ Mahalls
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Alt+Enter
o

File Eqfit View Actions

e S .--_00— L e ]

Sortable columns
Download, View as PDF
Hold/Release/Delete/Move actions
Filtering options

"|

=
Output name  User-specified data  User

FAYROLLFFF

PAYROLLFFF

FAYROLLFFF
P10BLO
F10B
FI10OB

REINHARD
REINHARD
REINHARD

Status  Printer Pages per copy  Copies left  Time created

=READY 28
*READY 21
*READY

PADEVOODY REINHARD | *READY

Q
Q
Q
QPADEVOODG REINHARD |*READY
Q
QPADEVOODG REINHARD | *READY

Retrieved 14 spooled files (6 selected)

Download Only
Download and View ?

View Only
Hold
Release
Delete
Move

Date

4/26
4/28/—
4/28/,

4126/

[

Downloaded Files

Name

| | =* PAYROLLFFF_REINHARD_QDF...
“¥ QPJOBLOG_REINHARD_QPAD...
¥ QPJOBLOG_REINHARD_QPAD...
- REINHARD_QPAD...
“¥ QPJOBLOG_REINHARD_QPAD...
¥ QPJOBLOG_REINHARD_QPAD...

¥ QPJOBLOG

Size

 39KB
- 6KB

10 KB
SKB
5KB
5KB

Modified

28/04/16 9:16 PM
29/04/16 9:17 PM
29/04/16 917 PM
28/04/16 9:17 PM
29/04/16 9:17 PM
29/04/16 917 PM

Open Delete

Active tasks

Spooled ...

QPJOBLOG...
QFIOBLOG...
QFIDBLOG...
QPJOBLOG...
QFIOBLOG...
QFIOBLOG...

Action

Download
Download
Download
Download
Download
Download




What’s new in RDi 9.5.1.1

» Refactoring capability — Rename ILE RPG declarations

* Preference for default open member action to be browse
versus edit

« 2 Kerberos APAR fixes
* Debug fixes require host PTFs

V/R1IMO PTF SI53473
V7/R2MO PTF SI63271
V/R3MO PTF S155962

17 other APAR fixes

© 2016 IBM Corporation
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Rename ILE RPG Declaration Refactoring

» RPG refactoring is the highest voted RFE

» Refactoring is the process of changing code without changing the function of
the code. The purpose of refactoring is to make the code more readable and
maintainable.

* Rename refactoring allows the user to rename all and only the symbols in an
ILE RPG file that are related to the user-defined name containing the cursor or
selection.

« This works for any user-defined name including file, record format, standalone
variables, data structures, subfields, procedures.

* It works within fixed, free and fully free (**FREE) source.

© 2016 IBM Corporation 59



Rename Refactoring — Invocation

*Place the cursor or select the name to rename in the Remote Systems LPEX

editor.

D

dcl-s PN int(10);

dcl-s arr

dcl-f file

dcl-ds qua
name ch (5]

end-ds;

X

Ifile

I
I

[ T T T e T e B

X = na
X = ar
qual.n

name

arr(na

file t

dcl-proc

Syntax Check Selection
Convert Selection To Free-Form

Save

Cut

Copy
Paste

Select
Selected
Deselect

Eilter view
Show a

Refactor
Source
View

Ctrl+5S

Ctrl+X
Ctrl+C
Ctrl+V

Alt+U

Ctrl+Alt+A

(p)

Rename... Alt+Shift+R

name = 1;
end-proc;

dcl-proc sub2;

dcl-s name int(1@);

Either right click or pull down the Source menu and select Refactor->Rename, or
press Alt+Shift+R.
*If the name is not a valid user-defined name, the Source->Refactor->Rename
will be disabled

© 2016 IBM Corporation
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Rename Refactoring — Specify new name

« After selecting the menu item, a dialog will appear prompting for the new name.

« The OK and Preview buttons will only enable once the new name is different
than the old one.

 Click OK to complete the process, click Preview to preview the changes that

will occur, or select Force preview and then OK to ensure that the changes are
previewed.

— If you select Force preview, this option will become the default for the next
time that you use the wizard.

@ Rename = @

MNew name: label

Force preview

Preview = | | OK | | Cancel
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Rename Refactoring — Preview

« The initial preview panel shows how many references there are to the
declaration that you want to rename in an informational message.

(3 Rename o || B &

Review the information provided in the list below. Click ‘Continue’ to proceed.

Found problems

i Found 19 references to "name”

No context information available

« If there are issues with the rename, warning or fatal messages will be shown. If
fatal messages, only Back and Cancel buttons are available.

(2} Rename = @

A fatal error occurred while performing the refactoring.

Found problems i
@ The renamed "arr{longnewname)” will overflow positions 43-62 of line 10:" 1 I 1 4an
© The renamed “arr(longnewname)” will overflow positions 12-25 of line 16:" € [arr(name)  Jadd arr(
© The renamed "arr{longnewname)” will overflow positions 36-49 of line 16:"  C  arr(name)  add [arr(r
@ The renamed "arr{longnewname)” will overflow positions 50-63 of line 16:"  C  arr(name)  add arr(r
@ The renamed "arr{longnewname)” will overflow positions 30-43 of line 19:" O [arr(name) ]’
i Found 19 references to "name”

4 I 3

Mo context information available
< Back l | Cancel
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Rename Refactoring — Preview

» Preview shows the changes that will be made before you apply them to the
editor.

@ Rename = @

Changes to be performed & 4 | B
V] # Rename N
» [#1#8 DelFreeAllUsanesFal enrnale - RemoteSustemsTemoFiles/| OCAI HOST/c/worksnaces/int/com ibm etools iseries edit tests/data/com ibme ™
< 1 »
& DclFreeAllUsagesEglen.rpgle VSt WS
Original Source Refactored Source
dcl-s name int(1@); L dcl-s label int(10@); -
dcl-s arr int(10) dim(%size(NAME)); dcl-s arr int(10) dim(%size(label)); [I
dcl-f file disk(2@) usage(*input : *output); dcl-f file disk(2@) usage(*input : *output)
dcl-ds qual qualified; dcl-ds qual qualified;
name char(1@) dim(3); name char(1@) dim(3); E
end-ds; end-ds;
D x 5 like(name) D x 5 like(1a
Ifile ns Ifile ns
I I 1 4 Bname I I 1 4 @la
I I 1 4 @arr(M: I I 1 4 @ar
X = name; x = label;
x = arr(Name}; x = arr(label);
qual.name(name) = ‘a’; qual.name(label) = "a’;
C eval name = arr(name) C eval label = arr(lak
C name add name nAMF C lahel add lahel [
] 1 » 4 1 »
< Back I l OK l l Cancel
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Rename Refactoring — Preview

« Expand the list of previewed changes to work with changes individually. Clear

the checkbox if you do not want a specific change to be performed.
=[5 fsl

© 2016 IBM Corporation

@ Rename

Changes to be performed

4 [/]% Rename

AR

s

4 %D DclfreeAllUsagesEglen.rpgle - RemoteSystemsTempFiles/LOCALHOST/c/workspaces/int/com.ibm.etools.iser| _

[¥]& dcl-s label int{10);
Q dcl-s arr int(10) dim(%size(label));
[¥] @ like(label) based(p)

V]2 label
Q arr(label)
W18  x=label

4 (L

# DclFreeAllUsagesEglen.rpgle

Original Source

Refactored Source

| dcl-s name int(10);

dcl-s label int(10); |

dcl-s arr int(10) dim(%size(NAME));
dcl-f file disk(20) usage(*input :

*

dcl-s arr int(10) dim(%size(NAME]
dcl-f file disk(20) usage(*input

< Back ] [ OK l l Cancel
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Rename Refactoring

« Click OK to update the editor.
— J/COPY members are not updated.
— Code that is excluded by /IF /ELSE statements will not be renamed.
— Only renames within a line are supported

« Use Undo if you want to revert the changes.
+ Documentation available at:

dcl-s label int(1@);
dcl-s arr int(10) dim(%siEe(label}};
dcl-f file disk(28) usage(*input : *output);
dcl-ds qual qualified;
name char(10) dim(3);

end-ds;
D x 5 like(label) based(p)
Ifile ns
I I 1 4 Blabel
I I 1 4 Barr(label)
x = label;

x = arr{label)};
qual.name(label) = "a’;

C eval label = arr(label)
C label add label label
C arr(label) add arr(label) arr(label)
0file t
0 label
0 arr(label)

dcl-proc sub;

label = 1;
end-proc;
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https://www.ibm.com/support/knowledgecenter/SSAE4W_9.5.1/com.ibm.etools.iseries.rse.doc/topics/refactor.html

Default all opens to be browse or edit mode

« When opening a member in the Remote Systems view, members can be

opened in edit or browse mode

« Now there is a preference to default to either browse or edit mode on the
Remote Systems>IBM i>Objects Subsystem preference page

7] e

@ Preferences (=] @
type filter text Objects Subsystem Gy~
R te Syst -
“ nemote ys_em_s Show type and subtype as extension
Communicatior D'sh : I : - . -
DataStore ow only exported procedures for service program objec
. Debug Expand tree on resource creation
File Cache Prompt if sequence numbers are detected when copying a local file to a source physical file:
Files *txt rE—
4 [BMi
Authenticatic
Cache Japanese CCSID 5026 and 5035 preferences
Command E . .
Convert backslash to Yen(¥) when saving IBM | members
Commands ¢
DDS Design Member saving behavior
IFS Files Subs - | | () Save directly to original member (%) Open Member In Editor 3wl
Jobs Subsyst (@ Save to a temporary member and then copy to original member
j < Connection: li?adtDG
IC))bJects S\L;b' [] Open source in browse mode
+ Program Ver .
. ECLIPSTEST ~
. Table View Library B Browse
Logging

» The Open Member in Editor dialog now also preserves
Open for edit / Open for browse value

© 2016 IBM Corporation

File: QRPGLESRC + (3]

Member: m

A B Browse...

@ Open for edit () Open for browse

OK

|

Cancel
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developerWorks » RFE Community > Servers and Systems Software

Servers and Systems Software
RFE Community

Qverview

Search Submit Releases My stuff

Groups

Help

Welcome usersl Here you have an opportunity fo collaborate directly with the product development teams and other

http://ibm.biz/rdi rfe

product users.

Filter the page content by brand and product

Servers and Systems Software ¥ Developer for Power Systems M J
Hot Top New Search o

122 RPG refactoring ability
votes

Delivered in 9.5.1.1¥

Delivered in 9.5 v

. . 29
Delivered in 9.5.1  vetes
= Voted

Delivered in 9.5.1  votes

© 2016 IBM Corporation

Would like to be able to perform refactoring on RPG code similar to the refactoring Eclipse can do with C++.

Refactor = Rename

Refactor = Extract Local Variable
Refactor = Extract Constant
Refactor =...

Uncommitted Candidate

Function to indent/format existing code similar to how "Source/Convert All ...

Would like to see a function to indent/format existing code.  Could work similarly to how "Source/Convert All to Free-
Form" works now, as well as "Convert Selection to Free-Form. on the context menu.

Delivered

support for mac in rdp
1 want to be able to run the RDP on my mac native.

Delivered

Identify where in the code you are at.

When editing er browsing through a socurce member in the LPEX editor, it would be helpful to know in what subroutine
or procedure you are at.  This weould eliminate the need to find BEGSR Previous.  SIm...

Delivered

Your ideas matter!
As of today:

5 new

2 planned

99 delivered

195 users
3913 votes
1988 comments

Spotlight

- RFE Community is
updated (Release 18)

=+ |BM Commerce adds
Payments (FTM) products
to the RFE Community

= IBM Secunty adds
MaaS360 products to the
RFE Community

- See all announcements

Give us feedback

Participate in the RFE

Community survey to help us

IMprove your experience.



http://ibm.biz/rdi_rfe

Delivered in 9.0.1

Delivered in 9.5.0.3

Delivered in 9.5.1.1

Delivered in 8.5.1

Delivered in 9.5.1

Delivered in 9.5.1

© 2016 IBM Corporation

65
votes

55
votes

votes

W \ote

5
votes

votes

W Vote

votes

W Vaote

votes

42
votes

Live Update of Content Assist

In RDP 8.5, we received live outline refresh, which is great. However for me, | always associated the outline with
content assist.  Except the content assist does not have visibility of the live outl...

Delivered

Integration of iIBM i Access database functions into RD Power

While bringing back the Database perspective was a step in the right direction, the IBM i Access database functions
are much more complete, especially Visual Explain .
I'd like to see the IBM i Acces...

Delivered

Add preference to default all opens to be browse only.

I 'want all my opens from features that allow a choice  to default to browse unless | choose other wise on that open
selection.

Uncommitted Candidate

Update outline view constantly

The outline view should be constantly updated with the new infermaticn from the editor when the user changed the
source code in the LPEX editor. At the momemt  the user has to click the refresh button...

Delivered

Trim Leading Spaces when joining lines (alt-J)

Being able to join lines with alt-J is very nice. It would be preferable if the join would tnim off leading spaces of what
is being joined and possibly add a single space so the join doesn't but up d...

Uncommitted Candidate

From a SQLxxxLE source, a "SQL prompter” on SQL lines
From a SQLxxxLE source, a "SQAL prompter” on SAL lines as we can have in SEU with the F4 function key

Uncommitted Candidate

Filter Outline by Referenced/Unref
Provide a means to filter fields/procedures/prototypes/ete by whether or not the meodule uses them.

Delivered

Automatic Content assist should be available as a preference

In the early days of WDSC content assist was automatic as it is with most other tools based on Eclipse. That
capability was removed and we now have to use Cril/Space to activate. This makes sense for ...

Delivered



RDi Fix List — RFEs delivered

hitp://ibm.biz/rdi_fix_list shows RFEs and APARs delivered by

release/fixpack
« 2 RFEs delivered in RDi 9.5.1.1

BFE31305 Refactoring support for ILE RPG
BFE14402 Add preference to default all opens to be browse only.

18 RFEs delivered in RDi 9.5.1

© 2016 IBM Corporation

REE13454

RFE12100

RFE12353

RFE31745
BEE11119
RFE64933
RFES6254
RFE29561
BEE23954
BFE74859

RFE45970

RFE87369
BEE38930
RFE77454
&

RFE77455
RFE23938
BFE60989

CAAC
ADO424

RFE86909

Mac OS X v10.11 support

Kerberos authentication for Rdi.

User can now use single-sign-on and enterprise identity mapping based on Kerberos to eliminate the need to provide logen credentials when

connection 1o the IBM i using Rational Developer for i.

Add toolbar button to ILE RPG outline view to toggle filtering out unreferenced fields/prototypes/data structures/procedures/files in the

outline view

Support ILE RPG O-Specs in dynamic outline and hyperlink/hover within RDi editor

Identify where in the code you are at - enhanced Show Block Nesting for SQL ILE RPG and ILE RPG
ILE RPG Live outline now supports *IN(nn) indicators

From ILE RPG Outline View position to O-Specs and track references to EXCEPT names

RDP 8.5 live outline view does not show field if used in internally described printer output

ILE RPG Outline view not showing indicator usage in program defined output specs

Context-sensitive help for embedded SQL in ILE RPG - F1on SQL statement will go to the particular statements help in the reference manual

Consolidated Project View - remote reconciler with remote contexts on IFS

Al projects in RDi except for i Projects can now be associated with an IFS location. From the project, right click Remote Reconciler -> Enable
Remote Support... to select the IFS location with the same name as the project. Use the Remote Reconciler view and disable the icon "Hide
files and folders that do not have pending changes" to view existing remote IFS files that can be imported into your General Project. From the

Remote Reconciler view, files can be pushed to and pulled from the IFS location.

See RFE45970 - IFS project support using RDi 9.5.1 blog post for additional information.

Always make Run SQL Scripts available, not just when in SQLRPGLE source - Objects subsystem popup menu has Run SQL Scripts action

Display additional parameter information in RPGLE content assist

RFE77454: Change ctrl-f to function like eclipse find

RFE77455: Make ctri-f function the same way in both block and stream modes

NOTE: Restrict search to selection is now enabled for both Block and Stream selection modes.

Automatic Content assist should be available as a preference

add commenting key shortcuts/actions for CL and DDS (like RPG)

Name Function
Comment Comment all lines containing the current selection.
Uncomment Uncomment all lines containing the current selection

MNOTE: The solution includes CL, CLLE and DDS source, but does not include OPM RPG or COBOL source.

Regular expression scan and replace

Keyboard Shortcut
Cul+/

Ctrl+\
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Conclusion

RPG is evolving rapidly and RDi is keeping pace (SEU is not)

Lot’s of goodies in RDi 9.5.1/9.5.1.1 — worth upgrading

We are prioritizing investment according to your feedback via RFE

With RDi, IBM | programming is cool and productive!
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Free-form RPG and RDi solves skill-depletion N

A
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Resources
Rational Developer for i

How to stay in touch

© 2016 IBM Corporation

— purchase, what's new
— is this an update, technical details
— simplest install for individuals
— options for enterprise installation
— personalized business case generator
- lots of online learning resources
- documentation and notices

— community, blog, announcements, wiki, links, resources
- very active discussion group
- request for enhancements

! A USERS GROUP !


http://ibm.biz/rdi_product
http://ibm.biz/rdi_product_evolution
http://ibm.biz/rdi_web_install
http://ibm.biz/rdi_install
http://ibm.biz/rdi_roi
http://ibm.biz/rdi_wiki_self_learning
http://ibm.biz/rdi_documents
https://ibm.biz/rdi_hub
https://ibm.biz/wdsci-l
http://ibm.biz/rdi_rfe
http://common.org/

